
  

 

 

Featured launch: Google Cloud Search 
Bringing the power of Google Search to G Suite customers 

● A smarter search experience, tailored for you 
● Breaking down information silos at work 
● Now a part of G Suite 

 

 

 

Work anywhere 
Searching for Google Drive files now easier on your Android phone  

 

 

 

Simple to use 
Insert videos from Google Drive in Google Slides  
Link to cell ranges in Google Sheets 
Support for rotated text, accounting number formats, and more in Sheets 
Redesigned unread messages indicators in Hangouts 
 

 

 

 

Business ready 
Resolve conflicting accounts with the new Transfer tool for unmanaged users 
A new admin privilege for managing custom templates in Google Docs Editors 
Improved phone prompts for 2-Step Verification 
Preview password-protected files in Google Drive 
Google Keep now a G Suite core service with controls and access in Docs 
Users with legacy Android devices can now access work apps in Google Play 

 

 
 

 

 

Learn more about G Suite  
Next ‘17 is coming soon: March 8-10, 2017 | San Francisco 
Browse for ways to automate workflows on the Transformation Gallery 
Google Cloud Connect (GCC): The community for G Suite administrators 
The G Suite Show  on YouTube 
What’s New for G Suite Admins  videos 

 
 
We’d really appreciate  your thoughts  on how we can make this newsletter work best for you. 

 
- The G Suite Team, March 1, 2017 

 
  

 

https://docs.google.com/a/google.com/forms/d/19AJmnJuG_JWdOTSf0B_kL1DFemE8bbkJbZ42Iz6uDx0/viewform


 

 

Featured launch: Google Cloud Search 
Bringing the power of Google Search to G Suite customers 

 Announced February 7th, 2017                          Share with your organization                                 - back to top - 

What’s new: Every day, people around the globe rely on the power of Google Search to access the world’s 
information. In fact, we see more than one trillion searches each year. As we continue to invest in new 
cloud-based technologies like machine learning to power our web search engine, we want to help businesses 
harness the same technology to search for internal information. In February, we announced Google Cloud 
Search (formerly known as Springboard), a new product that uses machine intelligence to provide a unified 
search experience across G Suite. 
 
Sorting through internal information has become increasingly complex as more and more companies move their 
data and workloads to the cloud. As a result, teams are working on hybrid environments and storing immense 
amounts of data all over and in various formats. From emails and docs to spreadsheets, slides, forms, internal 
sites, and many more. In fact, according to McKinsey, the average knowledge worker spends 20% of the 
workweek searching for and consolidating information. Simply put, employees are wasting a lot of time in the 
process of finding information they need to do their job. 
 
A smarter search experience, tailored for you 
Cloud Search brings the best of Google Search and machine intelligence to G Suite. It provides both 
comprehensive search and proactive recommendations to help you throughout your day. 
 
For example, when you open the Cloud Search app on your phone or laptop, you’ll see relevant information 
organized into simple cards (assist cards) that help you stay on top of your work. Assist cards are a new way to 
help you find the right information at the right time. Using Google’s machine intelligence technology, these cards 
can help you prepare for an upcoming meeting or even suggest files that need your attention. Assist cards are 
designed to be timely and relevant so that you can navigate your workday more efficiently. As we continue to 
learn how information is most useful to you, we’ll be adding more assist cards to Cloud Search over time. 
 

 
 
In addition to searching for information, you can also search for people listed in your company’s directory. You’ll 
see colleagues’ contact details, plus events and files you have in common. You can even choose to send an 
email, make a call, or start a Hangout with just a tap. 
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https://cloud.googleblog.com/2016/06/powering-a-more-connected-and-collaborative-enterprise.html
http://www.mckinsey.com/industries/high-tech/our-insights/the-social-economy


 

 

 
 
For businesses, privacy is a top priority. Cloud Search respects G Suite’s file sharing permissions, so people can 
only search for and find files that they have access to. This means that company resources like vacation policies 
can be found by everyone in your organization, but your team projects will only surface to people on your team, 
and your to-do lists will only be available to you. 
 
Breaking down information silos at work 
Since launching in the Early Adopter Program last summer, companies have been using Cloud Search to break 
down internal silos and access information more quickly. QAD, an ERP solutions provider for global 
manufacturing companies, helps businesses manage their finances, supply chain, business intelligence and 
more. Very little time can be spared sifting through documents to find what’s needed to make strategic business 
decisions, so QAD uses Cloud Search to help. 
 
“At QAD, we operate at a high-level of speed and require technology that provides us agility, flexibility and 
seamless access to information. Cloud Search provides that. It’s given us the ability to break down silos that 
exist across different content systems and unlock information with very little effort from IT, “ says Scott 
Lawrence Lawson, Director of IT Architecture. 
 
Now a part of G Suite 
Cloud Search is now available for customers using the G Suite Business and Enterprise editions. And this is just 
the beginning. In the future, we’ll be adding more capabilities to Cloud Search including integration with 
third-party applications. That way, you and your team can find, access and make the most of your information in 
G Suite and beyond. 
 
Once turned on for your organization, Cloud Search will be accessible at cloudsearch.google.com. 
 
For more information on Cloud Search, check out the Help Center: 

● Cloud Search Admin Help Center 
● Cloud Search User Help Center 
● Cloud Search Learning Center 
● Cloud Search Product Page  
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https://gsuite.google.com/products/cloud-search/
https://cloud.googleblog.com/2016/09/Google-and-Box-partner-to-transform-work-in-the-cloud.html
http://cloudsearch.google.com/
https://support.google.com/a/topic/7167202
https://support.google.com/cloudsearch
https://gsuite.google.com/learning-center/products/cloudsearch/
https://gsuite.google.com/products/cloud-search/


 

Work anywhere 

Searching for Google Drive files now easier on your Android phone 

 Announced on February 23rd, 2017                         Share with your organization                              - back to top - 

 
What’s new: It’s now even easier to find your Google Drive files wherever and whenever you need them. With this 
launch, Drive files and folders are now indexed via Firebase App Indexing and appear as results when you search 
for them in the Google app on your Android phone. Simply type your query and tap the “IN APPS” tab to view any 
Drive files relevant to your search. Select those files to open them in the appropriate app. 
 

 
 

Visit the Google Play Store to download the latest versions of the  Drive Android app .  
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https://firebase.google.com/docs/app-indexing/
https://play.google.com/store/apps/details?id=com.google.android.googlequicksearchbox
https://play.google.com/store/apps/details?id=com.google.android.apps.docs


 

Simple to use  
 

Insert videos from Google Drive in Google Slides 
 

 Announced on February 8th, 2017       Share with your organization                            - back to top - 

 
What’s new:  With this launch, you can insert and play your Google Drive videos in Google Slides, in addition to 
videos from YouTube. 
 

 
 
Once you’ve added a Drive video to your presentation, you can choose when to start and end it, whether it should 
autoplay when presenting, and whether it should be muted or play with audio. Simply right-click on the video and 
select Video options. 
 

 
If a person viewing your presentation doesn’t have permission to view a video embedded within it, they’ll be 
prompted to request access. 
 
Note that while you can play Drive videos in Slides on the web and mobile, you can only insert them from the web 
application.  
 
For more details, visit the  Help Center . 
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https://support.google.com/docs/answer/97447


 

 

 
 

Link to cell ranges in Google Sheets 
 

 Announced on February 13th, 2017       Share with your organization                            - back to top - 

 
What’s new: Because it can be difficult to navigate large and complex spreadsheets, we introduced the ability to 
link to specific cell ranges in Google Sheets on the web. 
 
With this new functionality, you can create a “table of contents” for your spreadsheet, direct others to specific 
content within your spreadsheet, and retain links to cells when you import spreadsheets from other applications. 
 
To link to cells in your spreadsheet, simply go to "Insert link" > "Select a range of cells to link" and type or 
highlight the desired range.  
 

 
 
 For more details, visit the  Help Center . 
 
 

Support for rotated text, accounting number formats, and more in Google 
Sheets 
 

 Announced on February 22nd, 2017       Share with your organization                            - back to 
top - 

 
What’s new: We’re working hard to ensure that Google Sheets meets your business needs. As part of that effort, 
we introduced several enterprise-friendly features that you’ve been asking for in Sheets on the web, Android, and 
iOS: 
 
Rotated text 
You can now rotate the text in a cell in Sheets (Format > Text rotation). This is especially useful when you need 
to fit long header names into thin columns, or when you simply want to fit more text on a single screen. 
 

 
 
Accounting number formats 
We made it easier to read your budgets, expense reports, and other spreadsheets containing monetary amounts 
by aligning the currency symbols within them (Format > Number > Accounting). We also made improvements to 
the way numbers, decimal points, and repeated characters line up to make them simpler to scan and analyze. 
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https://support.google.com/docs/answer/45893


 

 
 
More border styles 
You can now choose from several new border styles in Sheets, including various thicknesses and double 
borders, which are commonly used in financial statements like balance sheets (Toolbar > Borders > Border 
styles). 
 
Additional improvements on mobile 
In addition to the features described above, we also launched the following improvements to our mobile apps: 

● Support for using a mouse with the Sheets Android app 
● Ability to view and select existing custom colors in the Sheets Android app 
● Ability to drag and drop rows and columns in the Sheets Android and iOS apps 
● Formatting suggestions in Explore in the Sheets iOS app 

For more details, check out the Help Center articles below: 
● Help Center: Edit and format a spreadsheet 
● Help Center: Format numbers in a spreadsheet 
● Help Center: Edit rows, columns & cells in a spreadsheet 
● Help Center: See and use suggested charts and analysis in a spreadsheet 

 
 

Jump right back into the conversation with redesigned unread messages 
indicators in Hangouts 
 

 Announced on February 27th, 2017       Share with your organization                            - back to top - 

 
What’s new: In Google Hangouts on desktop and Android*, we’ve made some time-saving improvements to the 
way you navigate chats. When you enter a conversation where there has been a lot of activity, you’ll see a "Jump 
to Last Read" button. This will take you to the last unread message in your chat denoted by # new messages 
indicator. Additionally, the "# new messages" button has been redesigned to match the new UI.  
 
Check out the screenshot below to see how this works: 

 

 
 
* Note that this feature is already available for Hangouts on iOS 
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https://support.google.com/docs/answer/46973
https://support.google.com/docs/answer/56470
https://support.google.com/docs/answer/54813
https://support.google.com/docs/answer/6280499?co=GENIE.Platform%3DiOS&oco=1


 

Business ready 

Resolve conflicting accounts with the new Transfer tool for unmanaged users 

 Announced on February 14th, 2017      Admin feature                                      - back to top - 

 
What’s new: If your organization recently made the jump to G Suite, you may have employees who previously set 
up personal Google Accounts using your company’s domain name. With this launch, we’ve made it easier to 
identify and transfer those accounts before they become conflicting accounts. 
 
Using the new Transfer tool for unmanaged users, you can view all personal Google Accounts with email 
addresses that match the G Suite email addresses for your organization. You can then send emails to those 
individuals, requesting that they convert their personal accounts to G Suite accounts. Later, you can view the 
statuses of those requests and cancel them as necessary. 
 

 
 
If an employee accepts your request to transfer their account, you’ll be granted access to their data and given 
the ability to manage that account. If they decline or ignore your request, they’ll be asked to rename their 
personal account with a different email address when you create a new G Suite account for them. They’ll retain 
sole access to and control over all of the data in their personal account. 
 

 
 
Note that these actions must be performed manually. While you can send requests, cancel requests, and 
download request statuses for multiple users at once, you can’t yet do so in bulk via an API. 
 
We hope this launch will make the transition to G Suite easier for you and your end users alike.  
 
For more information about the Transfer tool, please visit the  Help Center . 
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https://support.google.com/a/answer/7062710
https://support.google.com/a/answer/6178645
https://support.google.com/a/answer/6178640


 

A new admin privilege for managing custom templates in Google Docs, Sheets, 
Slides, and Forms 

 Announced on February 15th, 2017      Admin feature                                      - back to top - 

 
What’s new: In November 2016, we introduced custom templates in Google Docs, Sheets, Slides, and Forms, 
allowing teams to spend less time formatting and more time brainstorming, collaborating, and sharing their 
ideas. We also gave G Suite Business, Education, and Enterprise customers the following optional controls in the 
Admin console: 
 

● Moderated - require that user-submitted templates be approved by admins with the Drive and Docs 
admin privilege 
 

● Restricted - restrict template submission to admins with the Drive and Docs admin privilege 

With this launch, it’s no longer necessary to provision the full Drive and Docs privilege to admins who want the 
ability to moderate and manage templates. Instead, you can grant those admins a new Docs Templates 
privilege, which gives them the ability to approve templates and modify template settings in the Admin console, 
but not the authority to change other Drive, Docs, Sheets, Slides, and Forms settings. Admins who retain the full 
Drive and Docs privilege will continue to be able to manage templates. 
 

 
 

 
 
This change will allow your organization to manage custom templates in a scalable way, without relinquishing 
control over sensitive admin settings.  
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https://gsuiteupdates.googleblog.com/2016/11/save-time-with-new-custom-templates-in.html
https://support.google.com/docs/answer/148833
https://support.google.com/a/answer/3055325#settings
https://support.google.com/a/answer/1219251#drive
https://support.google.com/a/answer/1219251#drive
https://support.google.com/a/answer/1219251#drive
https://support.google.com/a/answer/1219251#template
https://support.google.com/a/answer/1219251#template


 

 

 
For more details on the Docs Templates privilege and for instructions on managing templates, check out the Help 
Center articles below: 
 

● Help Center: Administrator privilege definitions - Docs Templates 
● Help Center: Enable custom templates for Docs, Sheets, and Slides 

 
 

Improved phone prompts for 2-Step Verification 

 Announced on February 22nd, 2017       Share with your organization  
- back to top - 

 
What’s new: In June 2016, we introduced phone prompts for 2-Step Verification, giving users another option to 
keep their accounts safe. With this launch, users who have opted into receiving phone prompts for 2-SV will 
notice improvements to the notifications they get when trying to sign in. For instance, when available, they’ll see 
additional details about the sign-in request, like when and where it was made. These improved prompts will 
appear on both Android and iOS devices. 
 

 
 
Check out the Help Center for more information on  2-Step Verification phone prompts . 
 
 

Preview password-protected files in Google Drive 

 Announced on February 23rd, 2017       Share with your organization                                      - back 
to top - 

 
What’s new: We know that you work with a variety of file formats in Google Drive. That’s why, with this launch, 
we made it possible to preview password-protected Microsoft Office documents, presentations, and 
spreadsheets in Drive.  
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https://support.google.com/a/answer/1219251#template
https://support.google.com/a/answer/3055325
https://gsuiteupdates.googleblog.com/2016/06/new-settings-for-2-step-verification.html
https://support.google.com/accounts/answer/7026266
https://support.google.com/accounts/answer/7026266


 

 
 
Now when you attempt to open one of these file types in Drive on the web, you’ll be prompted to enter the 
password and, upon doing so successfully, you’ll see a read-only preview of that document. 
 
Note that this feature also works when you open password-protected Office files sent as attachments in Gmail. 

 

Google Keep now a G Suite core service with Admin console controls and 
access in Docs 

 Announced on February 28th, 2017       Share with your organization                                      - back 
to top - 

 
What’s new: Available to G Suite users with Google Drive since 2013, Google Keep helps employees capture their 
thoughts, ideas, action items, and more in one easy-to-access place. With this launch, Google Keep is now a G 
Suite core service when used within a domain, and it has been added to existing G Suite agreements for most 
customers. In addition, Keep is now accessible in Google Docs, so employees can easily revisit and repurpose 
their notes. 
 
G Suite core service 
Keep now has the same technical support and service level commitments as any other core service, like Gmail 
or Google Drive. Going forward, domains using Keep will receive the following benefits: 

● Keep content will be handled as specified in your G Suite agreement. 
● Keep will be compliant with the terms, conditions, and service levels defined in the G Suite Technical 

Support Services Guidelines and the G Suite Service Level Agreement. 
● Keep will be added as a monitored service to the G Suite Status Dashboard. 

Additional admin controls 
In addition, we’re giving G Suite admins greater control over Keep usage in their organizations, by allowing them 
to turn the app on or off for their domains. The steps to do so will depend on an organization’s current use of 
Google Drive. For example: 
 
1. If you currently have Google Drive enabled for your organization, your users have had access to Keep and will 
continue to have access to Keep following this launch. If you would like to turn Keep access OFF, you can now 
do so from the Admin console (Apps > G Suite > Keep). 
 
2. If you do not have Drive enabled for your organization, your users have not had access to Keep. Should you 
choose to turn on Drive in the future, Keep will be turned ON for your organization if you’ve opted into 
automatically receiving new services in the Admin console and turned OFF for your organization if you’ve chosen 
to manually enable new services. You will be able enable or disable the application from the Admin console at 
any time. 
 

11 

https://gsuite.google.com/terms/user_features.html
https://gsuite.google.com/terms/user_features.html
https://gsuite.google.com/terms/tssg.html
https://gsuite.google.com/terms/tssg.html
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https://support.google.com/a/answer/6364906
https://support.google.com/a/answer/82691
https://support.google.com/a/answer/82691
https://support.google.com/a/answer/6364906


 

 
 
When turned on, Keep will respect a subset of the sharing settings applied to Google Drive. 
 
View and create Keep notes in Docs 
The improvements to Keep don’t just apply to admins. End users can now view and create Keep notes in Google 
Docs on the web. Starting today, simply select “Keep notepad” from the Tools menu to pull up a sidebar 
containing your notes from Keep (and the option to search them). You can then edit those notes and drag and 
drop them into your document. 
 
If you’re inspired by the content already in your doc, you can create a new note by highlighting the relevant text, 
right-clicking, and selecting “Save to Keep notepad.” Or, if you simply want to create a new note with brand-new 
content, you can start typing in the “Take a note...” box in the notepad. All notes you create while in a document 
will be added to a “related” section within the sidebar. When you then view those notes in Keep, they will include 
a link back to the document in which they were created. 
 

 
 
For additional details, check out Help Center: 

● G Suite Learning Center: Keep 
● Help Center: Get started with Keep 
● Help Center: Turn Keep on or off for users 
● Help Center: Set Keep sharing settings 
● Help Center: Use Google Keep in a document 

 

Users with legacy Android devices can now access work apps in Google Play 

 Announced on February 28th, 2017       Share with your organization                                      - back 
to top - 

 
What’s new: Earlier this year, we announced that your organization’s private apps would move from the “Private 
Channel” (i.e. the “domain.com” tab) to the “Work Apps” tab in the Google Play Store. We envision this Work 
Apps section as a single destination where users can find all of the applications they need to be productive on 
mobile. Using Google Mobile Management, G Suite administrators can offer a curated set of both public and 
custom apps to their employees in the Work Apps section of Google Play. 
 
Previously, however, employees with Android devices that did not support work profiles could not see the Work 
Apps tab and the apps their admins had curated. This included any users with Android devices running 5.0 
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https://support.google.com/a/answer/6367814
https://gsuite.google.com/learning-center/products/keep/
https://support.google.com/a/answer/6367639
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https://support.google.com/docs/answer/7298487
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https://gsuite.google.com/products/admin/mobile/
https://support.google.com/work/android/answer/6191949


Lollipop or less. With this launch, employees with these older devices can now access the Work Apps tab in 
Google Play (in their personal profile) and the apps their admins have curated. 
 

 
 
Note that on devices that do  support work profiles, the Work Apps tab can only be accessed from Google Play in 
the work profile. 
 
For more information, check out the Help Center: 

● Help Center: Manage Google Play private apps 
● Help Center: Publish private apps 
● Help Center: Manage apps on mobile devices  
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https://support.google.com/a/answer/2494992
https://support.google.com/googleplay/work/answer/6145139
https://support.google.com/a/answer/6328701


 

 

 

Learn more about G Suite 
Next ‘17 is coming soon: March 8-10, 2017 | San Francisco 

     Share with your organization                                                                                                            - back to top - 

 

 
 

 

    WATCH THE LIVE STREAM 
In just a week, thousands of developers, IT practitioners, and 
industry leaders will gather in San Francisco for Google Cloud’s 
premier conference. Join Diane Greene, Sundar Pichai, and other 
Google leaders to learn what Google Cloud offers today, our vision 
for the future, and how customers and partners are using Google 
Cloud to build what’s next.  
 

View the live stream here starting Wednesday, March 8, at 9 AM 
PST. 

 

Browse for ways to automate workflows on the Transformation Gallery 

     Share with your organization                                                                                                           - back to top - 

 

Automate workflows around the workplace 
In February the Transformation Gallery team kicked off a new blog 
series, Work hacks from G Suite. Check it out to get some tips for 
making processes automatic. Using tools like Forms, Apps Script, and 
Sheets you can streamline every day workflows from tracking 
employee compliance to requesting time off.  
 
Bookmark the Transformation Gallery and see what processes have 
worked for others in your industry or job function.  

 

Google Cloud Connect (GCC): The official community for G Suite Admins 

   Admin resource                                                                                                                          - back to top - 

 

Sign in today:  Google Cloud Connect (GCC) is your 
one stop shop for resources to make your work with 
G Suite easier. Sign in today to discuss best 
practices, ask questions, and communicate with your 
peers and Googlers. Don’t miss out! Make sure you 
follow our Community Manager, Lauren Gallegos, to 
get the weekly buzz. 

 
What’s new: In January, we continued our Editorial 
Calendar for 2017. We added new use cases to our 
growing catalog, covering topics like how to 
Automate your time-off request process and The 
first public cloud locations map.  

To top things off, Kim Wylie continued her Change Management series with articles on Google's Change 
Management Methodology for Deploying G Suite and G Suite adoption for high performing teams. Join us in 
March for more use cases on your favorite Google Cloud products.  
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https://cloudnext.withgoogle.com/
https://cloudnext.withgoogle.com/
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https://connect.googleforwork.com/thread/7983
https://connect.googleforwork.com/thread/7983
https://connect.googleforwork.com/docs/DOC-17353


 

 

 

The G Suite Show  on YouTube, every Tuesday, 11am PST 

     Share with your organization                                                                                                      - back to top - 

 

Halfway through Season 10! 
The G Suite Show  featured episodes for Google Classroom, 
focusing on individualized learning, the latest Chromebook with a 
stylus and world-facing camera, as well as the new Admin console 
reports. You can check out the episode here.  
 

Next, Lily and Jimmy share their favorite Gmail gems so you can 
easily tackle an unmanageable inbox. These gems feature ideas 
for labels, filters, integrated search, and schedule direct to 
calendar.  
 

When scheduling meetings, oftentimes we are forced to do it 
on-the-go. Have no fear as “Find a Time” for mobile is here! It 
easily scans your calendar and guest calendars to determine the 
next best time. Jimmy and Drea share new features for calendar 
here.  

Lastly, Drea and Jenny explain how businesses can make a virtual training hub using Google Sites and Drive. 
This is one of our most popular cards from the Transformation Gallery.  

 

 

What’s New for G Suite Admins  videos 

   Admin resource                                                                                                                                    - back to top - 

 

What’s new:   The What’s New for G Suite Admins  videos 
provide a recap of all of the features we've released in the 
past month that are relevant to G Suite Admins, so you can 
watch and share them whenever you want. 
 
How it works :  Bookmark the playlist on YouTube and check 
back each month for updates.  

 
 

Thanks for checking out our newsletter!  
We’d really appreciate  your thoughts  on how we can make this work best for you. 
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https://youtu.be/oBSN0lwqLVU
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